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I gang med DreamweaverLæs mere om...

Generelle bemærkninger 
Programmet Dreamweaver har været på markedet i nogle år efter-
hånden. Den seneste version hedder Dreamweaver CS5, og pro-
grammet er på engelsk.

Dreamweaver er en såkaldt grafisk editor, et program der bruges til 
at oprette og redigere htmlsider i. Filerne du laver i Dreamweaver 
er XHTML-dokumenter, som kan læses af en internetbrowser. De får 
betegnelsen .html 
Man skriver tekst direkte ind på siderne, og billeder hentes nemt 
ind med ”Drag and Drop”. (Billeder bør redigeres i et billedbehand-
lingsprogram, billedmaterialet til dette kursus er forberedt.)
For at kunne uploade sider til internettet, skal du bruge et FTP-
program (File Transfer Protocol). Dreamweaver har et FTP program 
indbygget, så du behøver altså ikke andre programmer end Dream-
weaver. 

Hvilken skærmopløsning?  
Et godt webdesign bør kunne ses med et rimeligt resultat i browser 
vinduer af varierende størrelse. Det betyder ikke nødvendigvis, at 
designet skal være perfekt i meget små eller meget store browser-
vinduer - men som hovedregel bør man teste et design inden for 
et større interval end standard størrelserne. I dag (oktober 2010), 
er den mest brugte skærmopløsning stadig 1024 x 768, når man 
ser bort fra bærbare computere. Hvis du vil lave en side til denne 
skærmopløsning og ikke ønsker scroll på siden, er maximum 900 x 
600 px, så er der lidt luft hele vejen rundt at give af.
Gør det til en god vane altid at tjekke skærmopløsningen på den 
skærm du selv sidder ved, og hold styr på sidens mål undervejs. 
Mange har fået en grim overraskelse, når de uploader deres site, og 
det viser sig, at de ikke har været opmærksomme på sidens mål, 
og derfor forekommer der uønsket scroll.

OBS 
Når du skal lave et site bestående af flere sider, er det en god idé 
at lave et layout og et navigationsdiagram på papir, før du starter 
ved computeren. En god planlægning kan spare mange timers 
arbejde.
Opret en hierarkisk struktur til mapper og undermapper som du 
finder logisk, og som eventuelle samarbejdspartnere kan forstå.  
Undgå så vidt muligt at omdøbe og flytte rundt på sider, filer og 
mapper, der vedrører websitet, efter du er startet. Det er menin-
gen, at programmet skal kunne håndtere dette, men erfaringen 
viser, at det kan være et svagt punkt.
Og så er det er en stor fordel, men ingen betingelse, at have kend-
skab til xhtml.

Opstart

Et navigationsdiagram er 
en skitse der viser 
sammenhængen mellem 
de enkelte sider. 
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Herunder ses brugerfladen i Classic Layout. Man ændrer bruger-
fladens udseende i menuen Window > Workspace Layout.
En god ting er, at du kan vælge at have koderne synlige, samtidig 
med dit designvindue er åbent. Denne tilstand kaldes Split. 

Visningsmåder

Filemanager

Paneler

Properties

En nem måde at markere et element 
på, er ved at pege på koden som vises 
nederst i vinduet.

Menulinje

Toolbar

Opstart

TitelVisning i Browser
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Design-visning 
I Dreamweaver kan en side vises på 3 forskellige måder: Code, 
Split eller Design.  
Design: indstillingen bruges når man vil designe siden med de 
visuelle værktøjer.  
Code: viser xhtml koder samt anden programmering der anvendes 
til at opbygge siden. Koderne kan redigeres her.  
Split: giver mulighed for at se både den visuelle del og koderne 
samtidig. 

Code view 
Hvis man vil håndkode siden, sker det via Code View eller Code 
Inspector. Code Inspector kan åbnes separat ved at vælge Window - 
Code Inspector eller bruge genvejen F10.

Quick Tag Editor 
Der er masser af hjælp at hente til at skrive koder. Hvis man 
taster en <, vil programmet straks vise de muligheder, der findes 
for tags.
Quick Tag Editor bliver brugt til at redigere i enkelte XHTML-koder 
uden at behøve at vise koden i et selvstændigt vindue. Vil du re-
digere en XHTML-kode tilknyttet et bestemt element, markerer du 
elementet og trykker ctrl+T.

Opstart

3



4

I gang med DreamweaverLæs mere om...

Page Properties 
I bunden af skærmvinduet findes panelet Properties. Det skal du 
bruge ofte, så der er god grund til at have det åbent hele tiden. I 
Properties findes også en knap for Page Properties - altså sidens 
indstillinger. Her kan man sætte baggrundsfarve, links mm.

OBS 
Vær opmærksom på, at indstillinger foretaget i Page Properties, 
bliver gemt som et internt Stylesheet, og vil altså kun gælde for 
den aktuelle side. Du lærer mere om Stylesheets senere i kursus-
materialet.

Opstart
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Overblik

Assets Management 
Ved at vælge Window > Assets eller F11, får du adgang til 
en meget praktisk funktion i programmet. Assets Manager 
bruges til at holde styr på alle elementerne i dit site.

Det kan være meget gavnligt at kunne se motiverne på de anvendte 
billeder, klik på ikonen for billeder og se et preview samt få oplyst 
billedets dimensioner.

Snippets 
Snippets betyder »bidder«, og denne funktion bruges til at gemme 
og genbruge et stump kode, hvilket kan gøre arbejdet lettere for 
dig. Du kan selv gemme kodestykker eller bruge dem, der allerede 
findes.

Få overblik over, 
hvilke billeder, 
farvekoder, links, 
flash osv. du har 
brugt. Ved at klikke 
på de små ikoner, 
kan du bladre 
igennem de 
elementer, der er 
anvendt på sitet.

Her ses de foruddefinerede 
mapper i Snippets. Hvis 
du vil lave din egen mappe 
til dine koder, skal du blot 
stille dig i feltet, højreklikke 
og navngive mappen. 

Opstart
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Opstart
Properties 
I bunden af skærmens vindue ses Properties. Her vises oplysnin-
gerne om det element, der er markeret på siden. Her kan man 
også redigere i elementerne. Det er en såkaldt kontekstafhængig 
værktøjslinje, hvilket betyder, at den ændrer udseende, alt efter 
hvilken type element der er markeret (i dette tilfælde et billede).

Toolbar 
Foroven på skærmen, lige under menulinjen, ligger toolbar.

Ved at klikke på de enkelte faner, vil der komme yderligere værk-
tøjer og funktioner til rådighed. Det er ikke altid nemt at huske, 
hvad de små symboler betyder, men holder du musen stille på et 
symbol, vil der komme en forklaring i en lille gul box.
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Opgave

Opstart

I gang med Dreamweaver

Forberedelse 
Inden du overhovedet åbner programmet, skal du samle dit ma-
teriale sammen og lave 2 mapper. Den første mappe kalder du for 
opstart. Hvis projektet gik ud på at lave et site for en kunde, f.eks 
Arla, ville man kalde mappen for Arla. I denne mappe ligger alt, 
hvad der har med sitet at gøre. Inde i mappen skal grafikmappen 
ligge. I denne mappe samler du al grafik til sitet. Det er ikke såle-
des, at man ikke kan tilføje grafikfiler undervejs, men ved at have 
oprettet mappen på forhånd, bliver fremtidige grafikfiler til sitet 
automatisk arkiveret heri. Du skal ikke selv oprette grafikmappen i 
denne øvelse, men importere den fra kursusmaterialet.

Opret et website  
Åbn nu Dreamweaver og vælg Dreamweaver Site i midterste kolonne.

. 

Giv sitet et navn.
Bestem hvor det skal arkiveres. Sitet skal ligge i den mappe, du 
kaldte opstart.

Mappen opstart med 
grafikmapppen indeni.
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Opgave

Opstart

I gang med Dreamweaver

Udfyld stien til grafikmappen således:
Klik på den lille pil i menuen til venstre og vælg Advanced Settings 
> Local Ibfo. Vælg mappen der hedder opstart_grafik.

Vælg Save.

Brugerfladen kan sættes forskelligt op, jeg har valgt Classic.

Filemanager
Properties
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Opgave

Opstart
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Preferences 
Inden du starter på selve sitet, kan det godt betale sig at kigge i 
Preferences, som er generelle indstillinger for selve programmet. 
Indstillingerne her gælder for alle fremtidige dokumenter, indtil de 
ændres samme sted igen. Jeg vil kun tage fat i en enkelt ting, men 
jo mere man arbejder med programmet, jo flere vaner og rutiner 
indøver man, og disse kan det være en fordel at tilpasse.

Åbn Preferences fra Edit menuen. Under Category vælges New 
Document. Bestem hvilken extension der ønskes på siderne: html 
eller htm. Der er ingen forskel - de er lige gode. Det er kun et 
spørgsmål om vane. Vælg OK.

 
Der er en arbejdsgang, som skal foretages, hver eneste gang du 
opretter et nyt site. Den kommer her i punktform, og de enkelte 
punkter bliver uddybet længere fremme i teksten eller i de tilhø-
rende opgaver. Du skal altså ikke gøre nedenstående nu, det er 
blot en præsentation af, hvad der skal ske senere. 

1. Opret en ny fil kaldet index.html, filen skal ligge i roden.
2. Opret en mappe kaldet html (hvis der er undersider).
3. Åbn index.html ved at dobbeltklikke på den.
4. Giv filen en titel.
5. Opret en ekstern Stylesheet fil.
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Opgave

Opstart

I gang med Dreamweaver

Husk at arkivere jævnligt. En lille stjerne i filnavnet betyder, at der 
er ændringer at arkivere.

Index filen med titlen udfyldt.

Filemanager med de filer og den struktur du skal anvende til hvert 
site.

Byg siden
Så er du klar til at arbejde på selve sitet. Den første opgave er 
beskrevet under afsnittet ”CSS baseret layout”.

Den lille stjerne 
indikerer, at der 
er ændringer til at 
arkivere.
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Billeder og internettet 
Der er endnu ikke frit valg på alle hylder, når det gælder billedfor-
mater og størrelser til brug på internettet. Vi får hurtigere forbin-
delser, og derved kan vi også tillade os at bruge større (tungere) 
billedfiler. Men det er stadig sådan, at den grund, de fleste angiver 
til at forlade en side, er ventetid, og her er billeder samt lyd og 
video de store syndere. ”Et billede siger mere end 1000 ord - og 
fylder mere end 1000 gange så meget” - er der en klog, der sagde 
for nogle år siden. Det gælder stadig.

Formater 
Dreamweaver læser de gænse formater, der kan fortolkes af en 
browser:

gif Graphic Interchange Format
jpg (eller jpeg, det er det samme) Joint Photograpic Experts Group
png Portable Network Graphics 

Opløsning
Billeder til brug på internettet skal have en opløsning (resolution) 
på 72 dpi.

Billeder og Dreamweaver
Det er muligt at foretage meget enkel billedredigering i Dreamwea-
ver. Programmet arbejder fantastisk sammen med Photoshop og 
Fireworks, og mere avanceret billedbehandling foretages der. 
I princippet bør et billede være færdigredigeret, når det hentes ind 
i Dreamweaver. 

Fy fy, skamme skamme
Det er forbudt at ændre billedestørrelsen inde på siden, ved at æn-
dre målene i Properties. Billedet bliver godt nok ændret på siden, 
men man beder brugerens browser om at foretage størrelsesæn-
dringen mens siden downloades, og det gør nu siden tungere.

Hvis man ved en fejl, er kommet til at hive i billedet, ses det nye 
mål med fed skrift. For at komme tilbage til 100%, klikkes på 
symbolet ved siden af målene.
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Indsæt 
et billede

Opgave I gang med Dreamweaver

Opgavebeskrivelse

Opret en ny mappe kaldet billeder. 
Hent mappen billeder_grafik i kursusmaterialet, og placér den i 
mappen billeder.
Åbn Dreamweaver og opret et nyt site kaldet billeder.
Importér grafikmappen billeder_grafik til sitet. 
Opret index.html, åbn denne. 
Der er flere måder at hente et billede ind på siden på. Du kan enten 
trække billedet direkte fra Filemanager og ind på siden, 

eller vælge symbolet for et billede øverst i værktøsjslinjen.

Eller vælge Insert > Image

OBS
Dette er kun en øvelse i hvordan du henter et billede ind på en 
side. Hvis du skal fremstille et seriøst site, skal du placere billedet i 
en div (se afsnittet om CSSbaseret layout).

Du vil måske opleve at 
ikonerne i værktøjslinien 
ikke svarer nøjagtigt til 
dit eget skærmbillede. 
Det skyldes at værk-
tøjslinjen altid viser det 
sidst valgte ikon. 
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Indsæt 
et billede
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Ved de 2 sidstnævnte metoder fremkommer en dialogboks, 
hvor du skal angive stien til billedet.

Uanset hvilken metode du anvender, skal du udfylde en alter-
nativ tekst. Denne tekst er vigtig, så gør det til en god vane 
altid at udfylde den.

•	 Teksten bliver læst op for synshandicappede.
•	 Teksten bliver vist på skærmen, hvis billedet af en eller 

anden grund ikke kan vises.
•	 Google bruger efter sigende også disse tekster. Det  

betyder, at det at udfylde feltet kan være en medvirkende 
årsag til, at sitet hurtigere bliver fundet.

•	 Teksten bliver vist i en lille gul boks, når musen føres hen-
over billedet.

OBS
Det er imidlertid ikke nok at udfylde den alternative tekst. 
Du skal, alle steder hvor du anvender den alternative tekst, 
også åbne sidens kode og selv tilføje title=”   ”. Du skal skrive 
samme tekst, som du brugte til den alternative tekst.

I Properties vises en thumbnail af billedet. Du kan se målene 
og datastørrelsen samt få oplyst stien til, hvor billedet be-
finder sig.
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Hotspot

Læs mere om...

Hvad er Hotspot 
Ønsker man at lave flere links fra det samme billede, et eksempel 
kunne være byer på et landkort, anvender man en funktion der 
kaldes Hotspots eller Image Map. Ideen er, at man udvælger flere 
forskellige felter på det samme billede, og hvert af disse felter får 
et selvstændigt link.

Ved at klikke på de enkelte byer på kortet vil man få forskellige 
sider frem.

14



1

I gang med Dreamweaver

Hotspot

Opgave

Opgavebeskrivelse 
Opret en ny mappe kaldet hotspot. 
Hent mappen hot_grafik i kursusmaterialet, og placér den i mappen hotspot. 
Åbn Dreamweaver og opret et nyt site kaldet hotspot. 
Opret filen index.html. 
Træk billedet landkort.jpg ind på siden fra Filemanager.

Markér billedet, således at der fremkommer en kraftig ramme omkring med håndtag 
i hjørner og midterpunkter. Når billedet er aktivt, vises værktøjerne til at fremstille 
hotspots med i Properties i nederste højre hjørne. 
Vælg firkanten, og træk nu en ramme rundt om symbolet, der forestiller en kirke. 
Der åbnes en dialogboks, som beder dig udfylde ”Alternate text”.  Se opgaven om 
”Billeder”, for yderligere information om ”Alternate Text”.
Skriv Sædding Kirke i Alt-feltet i Properties. Åbn Sousce Code, altså dokumnetet 
vist med html-koder og tilføj selv title=”Sædding Kirke”. Linket ser således ud:

I linkfeltet er der blevet indføjet en # (et dødt link), og denne ”havelåge” skal du nu 
udskifte med det rigtige link som er:
http://www.skjernguiden.dk/kirker/saedding.htm
Gentag proceduren med de andre ”seværdigheder”, find selv på nye adresser.
Se effekten i browseren og upload opgaven som aftalt med din underviser.

Alternate text

Hotspot 
markeret

Da det er et link ud af dit site, 
skal du vælge ” target_blank”

Der kan vælges firkantet eller 
rund facon. Med polygonen 
klikker man rundt på en figur.

Alternativ 
tekst
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Hvad er links? 
Hele ideen bag internettet er baseret på brugen af hyperlinks, i 
daglig tale blot kaldet links. World Wide Web er en stor samling af 
sider/filer, der er linket til hinanden, og det er ved hjælp af links, 
at man ”bladrer” eller browser rundt på internettet. I starten var 
de fleste sider udelukkende tekstbaserede og alle links var tekst-
links. I dag bruger vi både links på billeder og tekst, med eller uden 
understregning og i forskellige farver. Links er en naturlig del af en 
side, men der er forskellige overvejelser, man bør gøre sig, når det 
drejer sig om links.

Tekstlinks
Som udgangspunkt er links blå og understregede. Sådan har vi 
lært at links ser ud. I takt med at vi får lyst til at designe mere 
grafisk spændende sider, vokser behovet for at kunne ændre udse-
endet på links. Det er jo f.ex. en urimelig begrænsning, hvis man 
ikke kunne fremstille sider med blå baggrund, fordi det så ikke ville 
være muligt at se evt. links. Der er efter min mening ikke noget 
galt i at bryde med blå links som standard, når blot man overholder 
nogle ganske enkle forholdsregler:
Det skal klart fremgå, hvad der er links. Vær konsekvent i farve-
valget på hele sitet, og brug kun farven til links, ikke til tekst, som 
ikke er links. Hvis understregningen fjernes, skal det også gøres 
konsekvent.

Links på billeder
Mange mennesker finder det ikke naturligt at klikke på billederne på 
en side. Dette betyder ikke, at man ikke bør anvende billeder som 
links, overhovedet ikke. Igen skal man bare tænke sig om. Det skal 
tydeligt fremgå, at billedet er klikbart, og hermed mener jeg ikke, 
at man behøver at skrive Klik på billedet med store typer på hver 
side. Det bliver trættende at se på i længden. Det kan gøres mere 
elegant, naturligvis tilpasset den enkelte side. Hvis man laver et 
link på et billede, sætter programmet automatisk en blå ramme om 
billedet for at vise, at det er klikbart. Denne ramme kan man fjerne 
Se hvordan i opgavebeskrivelsen.

Interne/eksterne links
Et internt link er et link, der peger på en anden side i det aktuelle 
site, du sev har lavet. Interne links bør åbne i samme browservin-
due. Eksterne links derimod peger ud af sitet, altså til en adresse 
på internettet, som ikke er en del af det aktuelle site. Eksterne 
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links bør altid åbne i et nyt browservindue, således at man ikke 
kommer til at lukke hele sitet, når man er færdig med at stu-
dere det eksterne link.

Gør siden mere brugervenlig
Når du laver et link på et billede, vil Dreamweaver bede dig ud-
fylde en Alternate text. Dette anbefales varmt, da denne tekst 
bruges til flere forskellige formål. Du skal selv forfatte den og 
hav følgende i baghovedet:

1.	 Teksten vises i en lille gul kasse, når musen holdes over bil-
ledet.

2.	 Teksten vises i stedet for billedet, hvis det af en eller anden 
grund ikke bliver indlæst af browseren. 

3.	 Teksten læses op for synshandicappede, der har installeret 
software, der kan varetage oplæsning.

4.	 Du har mulighed for at skrive en uddybende tekst om  
billedet - så der er al mulig grund til at bruge funktionen.

Den samme funktion til et tekstlink hedder title og findes i 
Properties.
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Opgavebeskrivelse 
Opret en ny mappe kaldet links. 
Hent mappen links_grafik i kursusmaterialet, og placér den i map-
pen links. 
Åbn Dreamweaver og opret et nyt site kaldet links. 
Opret filen index.html. 
Opret en side mere, kald den side2.html.

Tekstlink 
Åbn index.html, sæt cursoren ind på siden og skriv ”Dette er et 
tekstlink”.

Markér teksten ved at trække henover den og vælg symbolet Point 
to File i Properties. Hold musen nede og træk så - det føles som en 
elastik - peg på side 2.html i Filemanager. Teksten på index.html 
bliver blå og understreget. Udfyld Title, ligeledes i Properties: ”Lin-
ket går til side 2”.
Linket virker ikke i Dreamweavers designvindue, du skal se siden 
i en browser. Tastaturgenvejen er F12, eller klik på dette symbol i 
værktøjslinjen.

Point to File
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Link på et billede 
Fra grafikmappen trækker du billedet eye.gif ind på index.html. 
Vælg igen symbolet Point to File i Properties. Hold musen nede og 
træk, peg på side 2.html i Filemanager. Billedet får en blå ramme. 
Fjern rammen ved at skrive 0 i feltet Border i Properties. 

Eksternt link
De to links, du lige har lavet, er interne links, altså links mellem 
sider i det samme site. Nu skal du lave et eksternt link, altså et link 
til en side på internettet, der ikke hænger sammen med det site, du 
sidder og arbejder på.
Træk grafikfilen dwlogo.gif ind på index.html, og lav et eksternt link 
på denne. Linket skal gå til Adobes hjemmeside, til den side der 
omhandler Dreamweaver. Et godt råd er altid at kopiere eksterne 
adresser, det er alt for nemt at skrive forkert! Når der er tale om et 
eksternt link, skal den fulde adresse med, i dette tilfælde er den: 
http://www.adobe.com/dk/products/dreamweaver/?promoid=BPBEM
Adressen kopieres ind i feltet Link i Properties.
Den sidste ting, der mangler, er at fortælle browseren, at linket 
ønskes åbnet i et selvstændigt browservindue. Dette gøres ved at 
vælge target_blank i Properties. De fleste mennesker vælger at 
lukke browservinduet, når de har besøgt et link, og hvis ikke linket 
åbner i et selvstændigt browservindue, lukkes hele sitet ned, og det 
er sjældent hensigten!

Arkiver og upload opgaven som aftalt med din underviser.
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Rollover
Hvad er Rollover?
Et billede kan udskiftes med et andet billede, når musen føres hen-
over, og/eller når der klikkes på det. Denne effekt kaldes Rollover.
Ofte bliver teknikken anvendt, når man bruger grafik som knap-
per på et website. Forestil dig en rød knap som bliver grøn, idet 
der klikkes på den. »Før og efter« visning er også et oplagt sted at 
bruge Rollover. Et eksempel kan være en hund der er blevet klip-
pet. Hundefrisøren tager 2 billeder et før klipning og et efter. 
For at lave en Rollover skal man bruge 2 billeder. Billederne skal 
have identiske dimensioner, ellers bliver det ene forvrænget, da nr. 
2 billede tager størrelse efter det første. I Dreamweavers design-
visning kan man ikke se effekten, den kan kun ses i browseren.

Da effekten jo er dynamisk, kan den ikke vises her. Billederne skal 
ligge ovenpå hinanden og skifte, når musen føres henover.
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Rollover
Opgavebeskrivelse 
Opret en ny mappe kaldet rollover. 
Hent mappen roll_grafik i kursusmaterialet, og placér den i mappen 
rollover. 
Åbn Dreamweaver og opret et nyt site kaldet rollover. 
Opret filen index.html og åbn denne. 
Vælg Menuen Insert > Image Objects > Rollover Image. 

Nedenstående dialogboks kommer frem. Her bestemmes, hvilke 
billeder der skal anvendes. Du skal ikke trække billederne ind på 
siden men i stedet angive stien.

Original Image  
Angiv stien til det billede der skal vises som udgangspunkt. 
I opgaven er det seal1.jpg.
Rollover Image 
Angiv stien til det billede der skal vises som rollover.
I opgaven er det seal2.jpg.
Sættes flueben i Preload Rollover Image loader browseren billedet 
med det samme, og ikke først, når brugeren fører musen hen over 
feltet. Generelt en god idé.
When clicked, go to URL 
Udfyldes hvis du ønsker at lave et link på billedet. Bemærk at der 
ikke findes en mulighed for at vælge Target Blank. Hvis du ønsker 
at linke ud af sitet (se opgaven om links), skal du åbne siden i kode-
visning og selv tilføje attributten target=”_blank”

OBS.
Effekten kan ikke ses 
inde i Dreamweaver. 
Vælg visning i en 
browser (f12).
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Rollover
Cursor=default
Når musen kører henover en Rollover, skifter cursoren automatisk 
udseende til en finger, også selv om der ikke er tilføjet et link. Det 
kan virke forvirrende, men det er heldigvis muligt at ændre curso-
rens udseende med CSS. Funktionen hedder Cursor og ligger under 
fanen Extensions. 
Da opgaven går ud på at lave en Rollover, kan du nøjes med at lave 
et internet CSS. Opret en Class Style, kald den .cursor, vælg Cur-
sor > default.

Markér billedet og vælg stylen cursor i Properties.

Se effekten i browseren og upload opgaven som aftalt med din 
underviser. 

Du kan komme ud for, at siden ikke umiddelbart kan vises. Hvis der 
kommer en gul bjælke foroven i dit browservindue, hvor der står 
at siden er blokeret, skyldes det, at effekten Rollover fremstilles 
ved hjælp af Javascript (et programmeringssprog), og at der i dine 
browserindstillinger ikke er givet tilladelse til at vise sider, der inde-
holder Javascript. Du kan uden problemer tillade, at siden vises.

Billedet er markeret, 
når der er en kraftig 
ramme omkring og 
”håndtag” i hjørner og 
midterpunkter.
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PopUp vinduer
Hvad er et PopUp vindue?
Et PopUp vindue bruges f.ex. til at vise et billede i en større størrel-
se. Når man klikker med musen på et lille billede, åbnes en større 
udgave af det samme billede i et nyt browservindue, som er tilpas-
set det store billede i størrelse. Det er det, man kalder et PopUp 
vindue. Det behøver ikke at være billeder, der bliver vist. Alt ind-
hold, der kan vises på internettet, kan åbnes i et PopUp vindue. Du 
kan også bruge et almindeligt tekstlink til at åbne PopUp vinduet 
med.

Hvorfor bruge PopUp vinduer?
Der er flere fordele forbundet med at bruge PopUp vinduer. 
1. 	 Du sparer plads på din side, både design- og 
	 datamæssigt. 
2.	 Du kan styre størrelsen og udseendet af PopUp vinduet - 		
	 hvilket øger brugervenligheden.

Hvis man linker direkte til et billede fx. en jpg.fil, vil billedet åbne i 
et nyt browservindue, som er alt for stort. Desuden vil der være en 
hvid margin foroven og i venstre side. Hele ideen med PopUp vin-
duet er, at det skal tilpasses indholdet, derfor skal PopUp vinduet 
være en htmlside med definerede mål. Der er et minimumsmål på 
250 x 100 pixels. Man placerer altså sit billede på en ny htmlside, 
og giver denne side de samme mål, som billedet har.
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I gang med Dreamweaver

PopUp vinduer

Opgave

Opgavebeskrivelse 
Opret en ny mappe kaldet popup.  
Hent mappen pop_grafik i kursusmaterialet og placér det i mappen 
popup. 
Åbn Dreamweaver og opret et nyt site kaldet popup. 
Opret index.html, åbn denne. 
Opret en ny mappe i Filemanager, kald den html. 
Opret en ny fil inde i htmlmappen kaldet popup.html.

Layout
Ideen er, at det lille billede placeres på index.html, og det store 
på popup.html. Når man klikker på det lille billede, vises det store 
billede i et PopUp vindue (et selvstændigt browservindue), der har 
nøjagtig samme størrelse som selve det store billede.

Her ses et skærmbillede 
af Filemanager med alle 
de nødvendige filer og 
billeder til opgaven.
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PopUp vinduer

Opgave

popup.html
Åbn siden popup.html hvorpå det store billede skal sidde, og træk 
billedet storegris.jpg ind på siden. Billedet måler 400 x 313 pixels. 
Sørg for at cursoren står på selve siden og ikke på billedet.
Vælg Properties > Page Properties. Sæt sidens Left margin og Top 
margin til 0 pixels, på den måde fjernes luften i venstre side samt i 
toppen.  Siden er færdig og skal arkiveres.

index.html
Åbn index.html og træk billedet af den lille gris ind på siden. Skriv 
teksten under billedet.
Markér billedet og indsæt en # i linkfeltet i Properties. 
Fjern evt. borderen om billedet ved at skrive 0 i borderfeltet i Pro-
perties.

Åbn Window > Tag Inspector. Klik på det lille plus under Behaviors. 
En menu ruller ned, her skal du vælge > Open Browser Window.

Et PopUp vindue er en såkaldt 
Behavior (en handling). Når der 
skal knyttes en Behavior til tekst 
eller billede, skal man markere 
den tekst eller det billede, der ved 
en musebevægelse (mouseover 
eller mouseklik) skal udløse en 
handling og tilføje en # i linkbok-
sen i Properties.
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I gang med Dreamweaver

PopUp vinduer

Opgave

En dialogboks fremkommer, hvor du nu skal bestemme udseendet af 
PopUp vinduet.

Du kan ikke se effekten i Dreamweavers designvindue. Se resultatet i 
browseren (F12), og upload opgaven som aftalt med din underviser.

Angiv URL-en til den html-
side, der skal poppe up.

De nøjagtige 
mål på PopUp 
vinduet. Målene 
er identiske med 
billedets størrelse.

Der skal ingen flueben være, hvis vinduet 
skal stå helt rent uden nogen funktioner.
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CSS

Læs mere om...

Hvad er CSS? 
Cascading Style Sheets, fremover forkortet til CSS  (på dansk  
typografiark) bruges til flere ting: rationalisere arbejdet, nøjagtig 
placering af elementer, arbejde i lag og til at øge æstetikken.  
I Dreamweaver er CSS fuldt integreret og sider lavet i pro-
grammet anvender CSS - også uden at brugeren har bedt om 
det. Det er vigtigt at forstå, hvad CSS er, og hvordan det an-
vendes for at kunne få det optimale ud af programmet og for 
at kunne styre placering og udseendet af tekst og billeder. 

Rationel arbejdsgang 
CSS er et uundværligt værktøj, når man først har lært at anvende 
det. Man foretager ændringer ét sted, og samtlige sider i sitet bli-
ver opdateret. Et eksempel kan være, at kunden ønsker alle links 
røde uden understregning. Denne formatering kan man nøjes med 
at foretage ét sted, i stedet for at skulle markere hvert enkelt link 
på alle sider.

Styling 
CSS er et mere avanceret og fleksibelt programmeringssprog end 
html og xhtml, og det bygger naturligt oven på disse. CSS giver 
langt større mulighed for at lave et flot og spændende design, og 
bruges altså til at style udseendet af siderne - i modsætning til 
templates som man bruger til at styre indholdet på siderne.

Internt - eksternt CSS 
Det mest almindelige - og fornuftige - hvis der er tale om mere end 
én side, er at anvende et eksternt CSS. Et eksternt CSS - som er 
en fysisk fil med efternavnet .css placeres i Filemanager, og ideen 
er, at alle siderne i sitet henter formateringsoplysningerne fra netop 
denne fil. Man linker sine sider til css filen. Dette betyder, at man 
kun skal lave de forskellige indstillinger én gang frem for at skulle 
dykke ned på hver enkelt side.

Et internt css tilnkyttes den enkelte side, og har altså kun virkning 
for netop denne side. Formateringsoplysningerne står kun i sidens 
koder. Det er muligt både at arbejde med eksterne og interne CSS. 
Det interne CSS overruler det eksterne. Der er ingen forskel på, 
hvordan man fremstiller interne og eksterne Stylesheets, men de 
oprettes forskellige steder.

CSS er et meget omfat-
tende emne, og det er 
kun det mest grundlæg-
gende der bliver gennem-
gået på dette kursus. 
Du kan læse mere om 
CSS på Adobes egen 
hjemmeside eller på html.
dk.
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CSS

Læs mere om...

Styles 
Der arbejdes med 3 forskellige typer af styles.

Tag Styles
Tag Styles er baseret på valide htmlkoder, hvilket betyder at de 
kun kan hedde noget, som er kendt html, eksempelvis <td> <a> 
<body> osv. Der findes en komplet liste i Dreamweaver til at væl-
ge fra. Tag Styles træder automatisk i kraft på siden. 

 
Class Styles
Class Styles navngiver man selv, og de skal manuelt tilnyttes 
elementerne på siden. Et eksempel kan være, at man ønsker en 
stiplet ramme på én tabel, men ikke på de øvrige tabeller på sitet. 
Hvis man valgte at style med en Tag Style <table>, ville stylingen 
gælde for samtlige tabeller. I stedet laves en Class Style, og denne 
tilknyttes kun den ene tabel. En Class Style overruler en Tag Style.

Id Styles
Har samme funktion som Class Styles, men med den forskel, at de 
ikke kan genbruges på samme side - de har deres egen id, deraf 
navnet. Disse bruges bl.a., når man arbejder med lag (div baseret 
layout).
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Sider bygget
med div

Læs mere om...

Hvad er en div? 
Moderne weblayout bygger i dag på div'er, hvor man tidligere an-
vendte tabeller. Så hvad er en div? 
En div (division) kan opfattes som en kasse, man kan fylde indhold 
i. Først når den tildeles forskellige egenskaber, bliver den synlig. 
Div’er kan enten være relative, så ligger de ved siden af hinanden 
eller absolutte, så kan de ligge oven på hinanden og kaldes så også 
for lag. 

Master
Når du starter et nyt site, skal du starte med at lægge en div ind. 
Denne første div kalder jeg for master, men du kan kalde den hvad 
du vil, når blot de almindelige regler for navngivning overholdes. 
Div’en skal have position relativ som den eneste. Den er ikke et 
lag, den kan ikke flyttes rundt på siden, den ligger i baggrunden.

Div’er
Derefter er du er nu i stand til at placere alle de selvstændige lag 
på siden (div’er med position absolut), som du måtte ønske. Disse 
skal alle placeres inde i masteren. På denne måde vil deres posi-
tion blive fastholdt på siden af masteren. 

OBS
Denne metode egner sig til statiske sider, hvilket vil sige, sider med 
en fast højde, der ikke skal kunne udvide sig. Hvis du vil bygge 
dynamiske sider (sider med fleksibel højde), skal du følge anvisnin-
gerne i materialet på kurset ”Videre med Dreamweaver”.
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I gang med Dreamweaver

Nolde Museet

Opgave  

Opgavebeskrivelse

Lav et website om Nolde Museet i Sønderjylland. Opgaven fører dig 
igennem de basale ting hvad angår opbygningen af en side med 
CSS. Der er ikke tale om et komplet site, men du kan bruge opga-
ven som en slags skabelon til at opbygge mere omfattende sider 
ud fra. Hvis du ikke er fortrolig med at oprette et eksternt CSS, bør 
du læse afsnittet om CSS først og prøve at lave et eksternt CSS ud 
fra navigationssedlen om CSS.

Layout

Mål og CSS
Størrelse: 450 x 400 px (master), baggrundsfarve lys gul
header (div’en der indeholder overskriften): 450 x 50 px
left (div’en til venstre): bredde 200 px
right (div’en til højre): bredde 200 px
topmargin: 50 px
Overskrift (h1): Verdana 40 px, blå farve som slipset
Mellemrubrik (h2) : Verdana 24 px, bold, blå farve som slipset
Brødtekst: Verdana 11 px, blå farve som slipset
Indholdet er centreret horisontalt i browservinduet

450 px

400 px

50 px

200 px 200 px

50 px

h1

h2
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Nolde Museet

Opgave  

Forberedelse

Opret en mappe kaldet nolde.
Hent mappen nolde_grafik i kursusmaterialet, og placér den i map-
pen nolde.

Byg siden
Åbn Dreamweaver og opret et nyt site kaldet nolde.
Opret index.html, åbn filen og giv den titlen Nolde Museet. 
Vælg Insert > Layout Objects > div tag
Vælg ID og kald den for master
Vælg New CSS Rule

Da det er den første style, der 
bliver defineret, skal program-
met først vide, om der er tale 
om et internt eller eksternt 
CSS. Vælg New Style Sheet 
File for at oprette et eksternt 
CSS.
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Nolde Museet

Opgave  

Dialogboksen hvor du skal navngive og
arkivere det eksterne CSS.

Når CSS filen er arkiveret åbnes CSS editoren:

Definér master

Kald filen for basic, og 
placér den i roden af sitet. 
Filen kan hedde hvad som 
helst, blot ikke indeholde 
specialtegn som æ,ø,å o.l.

Fanen
Positioning

Fanen 
Box

Højre og ven-
stre margin 
sættes til auto 
for at centrere 
siden horison-
talt.

Som den eneste div, 
skal masteren have 
position relativ.
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Nolde Museet

Opgave  

Klik OK og se masteren på siden.

Definér ”*”
Da de forskellige browsere fortolker CSS forskelligt, er 
det en god idé at nulstille margin og padding på alle 
elementer, dette gøres ved at definere en universel 
selector (en stjerne). På denne måde fjerner du al luft 
der er lagt på default i programmet og dette betyder 
at du selv har mere styr på de enkelte elementers 
placering. 
Vælg New CSS rule nederst i CSS paletten.

Fanen
Background

basic.css optræder nu i 
CSS paletten med den 
første style defineret.

Vælg en lys 
gul farve til 
baggrun-
den ved at 
klikke på 
den lille far-
vefirkant.
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Nolde Museet

Opgave  

Vælg ID og kald den for *

I CSS paletten kan de 2 styles ses. Hvis 
man klikker på dem, kan man forneden 
i paletten se deres egenskaber. Man kan 
redigere alle styles her i stedet for at åbne 
editoren.

Fanen 
Box

Egenskaberne for ”*”
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Nolde Museet

Opgave  

Definér header

Headeren bruges i dette eksempel til overskriften. Det kunne lige 
så godt have været til en menu, det er blot en kasse som ligger i 
et lag ovenpå masteren, der kan fyldes indhold i. Det kan være lidt 
vanskeligt at få placeret cursoren det rigtige sted, når head skal 
indsættes. Det sikreste er at åbne kodevisningen og placere 
cursoren mellem <div id=master> og </div>. Du kan også holde 
øje med, hvad er står i fletet ID i Properties - der skal stå master.

Vælg Insert Layout Objects > div tag.
Vælg ID og kald den for header.
Vælg New CSS Rule.

Her ses div’en head inde i masteren. Div’en er gennemsigtig. 
Her jeg har her valgt at give den en lidt mørkere gul farve, blot for 
at du tydeligere kan se, hvor den ligger.

Fanen
Positioning

Div’en ligger inde 
i masteren, og det 
er øverste venstre 
hjørne, der er ud-
gangspunktet. 
Menuen placeres 
10 px nede for at 
skabe lidt luft 
mellem tekst og 
baggrund.

... og sådan skal kodestumpen 
se ud i kodevinduet

<body>

<div id="master">

  <div id="header">Content 

for id "header" Goes Here</

div>

</div>
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Nolde Museet

Opgave  

Definér left 
Vælg Insert Layout Objects > div tag.  
Vælg ID og kald den for left. 
Vælg New CSS Rule.

Definér right
Vælg Insert Layout Objects > div tag.
Vælg ID og kald den for right.
Vælg New CSS Rule.

Højden defineres 
ikke. Billedet spænder 
automatisk kassen ud.
Placeringen 60 px fra 
top er målt fra maste-
rens overkant.

Bemærk at det nu er 
afstanden fra højre, 
der defineres.
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Nolde Museet

Opgave  

Definér body 
Body er ikke en div, body er ikke en kasse. Body et et tagstyle, 
hvor du kan definere font (skrift) til hele sitet, baggrundsfarve til 
hele skærmen eller baggrundsbillede til hele skærmen. I opgaven 
her defineres fonten til brødteksten.

Vælg New CSS Rule i CSS paletten.
Vælg Tag og kald den for body.

Font, størrelse og farve. 

Fanen 
Type
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Nolde Museet

Opgave  

Definér h1 og h2 
Overskrift og underubrik er heller ikke div’er. Det er ikke kasser, 
men tagstyles der bruges til at definere udseendet af overskriften 
og underrubrikken.

Vælg New CSS Rule i CSS paletten.
Vælg Tag og kald den for h1.

Vælg New CSS Rule i CSS paletten.
Vælg Tag og kald den for h2.

Så skulle alle styles være definerede, og 
nu kan de så tilknyttes siden. 
Til højre herfor ses en oversigt over alle 
styles til siden.

38



10

I gang med Dreamweaver

Nolde Museet

Opgave  

Erstat teksten ”Content ...” med den rigtige overskrift: Nolde Museet.
Markér teksten og vælg i Properties Format > Heading 1

Kopier teksten fra txt. dokumentet, indsæt den i div right. Markér 
øverste linje og vælg i Properties Format > Heading 2

Træk billedet ind i div left.
Det færdige resultat set i designvisning.

Ved at flytte lidt på div left og div right, er det muligt at få fælles 
overkant på de 2 spalter, det vil pynte på resultatet. Når du rykker 
med et lag inde på siden, bliver målene automatisk opdateret i 
CSS filen. 
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Tabeller

Læs mere om...

Hvad er tabeller? 
Tabeller er ikke oprindeligt lavet til at kunne styre et layout med, men 
til at kunne opstille eksempelvis data i tabelform med (deraf navnet). 
Tabeller var tidligere det mest anvendte værktøj til at bygge websites 
med. I dag bruger langt de fleste CSS. Tabeller kan fint kombineres 
med CSS, det ene udelukker ikke et andet. Tabeller indsættes ved 
at vælge ikonet fra Toolbar øverst  på siden. Herefter kan man speci-
ficere antallet af rows (lodret) og columns (vandret), bredde, border 
(ramme) mm. Eventuelle ændringer kan man foretage i Properties.

Et par begreber
Her følger nogle begreber, som det er godt at have styr på. De bruges, 
når man anvender tabeller, men også når man arbejder med CSS, 
derfor er de værd at nævne her:

Padding
Afstanden fra indholdet i cellen (tabeller) eller kassen (div) og ud til 
kanten af cellen eller kassen.

Spacing
Afstanden mellem cellerne (tabeller).

Margin
Kant rundt om tabeller eller kasser, dvs. afstanden til de omkringlig-
gende elementer.

Border
Ramme på enten tabel eller kasse. Udseendet kan styles med CSS.

Column (celle)

Row

Cellpadding Cellspacing

Border

(række)
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Opgavebeskrivelse 
Opret en ny mappe kaldet tabeller. 
Åbn Dreamweaver og opret et nyt site kaldet tabeller. 
Opret filen index.html, åbn denne. 
Indsæt en tabel med 3 kolonner og 13 rækker. 
Vælg Insert > Table

Indskriv teksten herunder. Man skriver direkte i cellerne.

Her ses skemaet  uden farver og CSS.

Giv de 3 kolonner farver som på layoutet. Træk med musen hen-
over de celler, der skal farves, og vælg Properties > Bg. 
Centrér indholdet i de 2 højre kolonner horisontalt ved igen at 
trække henover de berørte celler. Vælg Properties > Horz > center

Layout

Farver
Måned	 #ffffcc
Luft		  #ccffff
Vand		  #00cccc

41



2

Tabeller

Opgave I gang med Dreamweaver

Nu skal tabellen styles, dvs. vi skal bestemme, hvilken font (skrift), 
der skal anvendes. Der skal en sort ramme omkring hele tabellen, 
og der skal lidt luft ind mellem tekst og ramme (Padding).

CSS 
Opret et eksternt CSS og lav et Tag Style kaldet td.  
Font: Arial 
Size: 11 px 
Denne style bevirker, at programmet anvender fonten Arial, 11 px, 
hver eneste gang der forekommer en celle (td). Det er ikke nød-
vendigt at angive farven. Hvis intet andet er angivet, skriver pro-
grammet med sort.

Opret endnu et Tag Style kaldet table.
Vælg Border
Style : solid
Width: 1px
Color: sort
Denne style bruges til at lægge en sort ramme om tabellen. Hvis 
der var flere tabeller på siden, ville de alle få en sort ramme.
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Opgave I gang med Dreamweaver

Resultatet hvor font og border er defineret. Der er stadig luft mel-
lem cellerne, og der ligger også en border rundt om alle celler på 
1 px. Markér tabellen og vælg Border=0 samt Cellspacing=0 i 
Properties.

Nu mangler der kun lidt luft fra teksten og ud til borderen. Denne 
luft kaldes Padding. Padding kan tilføjes på flere måder, i dette ek-
sempel bygger vi den ind i den style, du allerede har lavet for td. 
Åbn stylen td ved at dobbelklikke på den i CSS paletten.

Vælg fanen Box > Padding > Same for all > 2.
Denne indstilling betyder, at der bliver lagt 2 pixels ind om alle 
tekster i alle cellerne på alle 4 sider. 
Prøv evt. andre indstillinger ved at fjerne fluebenet i ”Same for all”.
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Opgave I gang med Dreamweaver

Det færdige resultat med paddingen tilføjet.

Upload opgaven som aftalt med din undersviser.
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Upload

Læs mere om...

Hvad er upload? 
Når du har bygget dit site og er tilfreds med resultatet, skal det 
uploades til internettet. Der sker nu det, at du kopierer dine filer 
over på en webserver, hvorfra de så kan ses af alle andre.

Når du skal uploade, skal du bruge de oplysninger, du har fået af 
din underviser. Hvis der var tale om et domæne, du selv ejer, ville 
du have disse oplysninger fra din udbyder. Det du skal bruge er:

- Webserverens navn
- Webstedets adresse
- Login og password

Til selve processen kræves et FTP program (File Transfer Protecol).
Et FTP program er et enkelt program, som udelukkende har til 
formål at flytte filer fra din computer til en webserver, som så igen 
har forbindelse til internettet. Dreamweaver har et FTP program 
indbygget, så selve upload proceduren-sker igennem Dreamwea-
ver. Hvis man håndkodede sit website, (altså ikke anvendte Dream-
weaver), ville man have brug for et FTP program. Disse findes 
gratis til download fra internettet. 

OBS 
Det er helt afgørende, at alle filer, der hører til sitet, bliver uploa-
dede, og at strukturen på webserveren er identisk med den på din 
egen computer. Ellers vises sitet ikke korrekt, og dine links virker 
ikke.
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Upload

Opgave

Opgavebeskrivelse 
Det er udmærket at prøve denne procedure mere end én gang, 
men hvorvidt du skal uploade alle dine opgaver til en webserver, 
aftales med din underviser. I dette eksempel vil vi uploade opgaven 
PopUp vinduer.

I filemanager ses alle de filer, der hører til sitet. Hvis der mangler 
nogle billeder eller filer, vil sitet ikke vises korrekt på internettet.
Klik på det lille symbol der forestiller et han-og hunstik for at skabe 
forbindelse til webserveren.

Når du klikker på symbolet for forbindelse til web-
serveren, kommer du tilbage til opsætningsme-
nuen. Klik på det lille + for at at åbne vinduet hvor 
indstillingerne kan foretages

Udfyld felterne 
med de oplysnin-
ger du har fået af 
din underviser.

Vælg test for at 
kontrollere at 
oplysningerne er 
korrekte.
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I gang med Dreamweaver

Upload

Opgave

Hvis oplysningerne er korrekte, vises denne dialogboks, og du 
kan vælge OK.

I filemanager kan du se, at ”stikket nu er sat i”.

Vælg nu symbolet yderst til højre. Ved at klikke her, ser du 
webserveren i et todelt vindue sammen med dine lokale filer.

På webserveren opretter du en mappe. Denne mappe bliver en 
del af navnet på din adresse på internettet, så husk: ikke æ,ø 
og å, mellemrum eller andre specialtegn. I eksemplet her har 
jeg kaldt mappen for popup_site, og det er heri, alle filer skal 
ligge. De skal ligge i samme struktur, som da du oprettede 
dem i Dreamweaver.
Du uploader dine filer ved at trække dem fra det højre vindue 
til det venstre. Det er vigtigt, at strukturen i begge vinduer er 
ens. Hvis nogle filer bliver placeret i andre mapper, end hvor 
de hører til, vil dine links ikke længere virke.
Du lukker vinduet igen ved at klikke på symbolet, der også 
åbnede det. 
Du kan nu se dit site på internettet.

Webserveren Dine lokale filer
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Fase Forklaring Navigation

Navigationsseddel

Mappen skal indeholde alle elementer til dit 
site.

Opret en mappe indeni den første og kald 
den grafik. Heri lægges alle dine grafikfiler.

Åbn programmet og vælg Dreamweaver 
Site. 

Udfyld sites navn, angiv stien til din ho-
vedmappe. Klik på den lille pil i menuen til 
venstre og vælg Local Settings.
Vælg mappen der hedder opstart_grafik.

Først nu er programmet åbent, og du er klar 
til at arbejde med selve sitet. I Filemanager 
ses sitet med grafikmappen.

Forsiden til dit site skal hedde index.html og 
arkiveres i roden. Højreklik på hovedmap-
pen og vælg New File, og skift navnet til 
index.html.

index.html er klar. Åbn denne og opret 
eksternt CSS og en mappe til evt. undersi-
der kaldet html.

Opret  hovedmappen

Opret grafikmappen

Opret dit site

Indtast oplysninger

Se programmets  
brugerflade

Opret index.html

Øvrigt indhold

 Opstart af et site
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Navigationsseddel

Et billede skal monteres på en htmlside.

Åbn Filemanager og træk billedet herfra ind 
på siden.

Vælg fra Insert > Insert Image eller symbo-
let i værktøjslinien.

Angiv stien til billedet ved at markere det i 
mappen.

Teksten bliver læst op for synshandicap-
pede, og giver dig mulighed for at beskrive 
motivet yderligere. 

Åbn en htmlside

Træk billedet ind på siden

eller

Vælg symbolet for et 
billede eller brug menuen 

Skriv stien

Udfyld den 
alternative tekst

Indsæt et billede 
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Navigationsseddel

Træk et billede ind på siden fra File-
manager.

Billedet skal være aktivt for, at du kan bruge 
værktøjerne til at fremstille Hotspots med.

                  

Der kan vælges mellem en firkant, en cirkel 
eller en polygon til frihåndsmarkering.

Før cursoren ind på siden og indram det 
ønskede felt. Markeringen vises med blåt.
Denne farve kan du selv ændre, og den 
bliver ikke at se på internettet.

Når du har indrammet feltet, der ønskes 
som link, bliver du bedt om at udfylde en 
alternativ tekst. Teksten bliver læst op for 
synshandicappede. Den giver dig også 
mulighed for at beskrive, hvad brugeren får, 
ved at klikke på linket.

Åbn Code og tilføj selv: title=»Sædding 
kirke«

I linkfeltet har programmet sat et dødt link, 
en såkaldt »havelåge«
Udskift det døde link med den rigtige 
adresse.
Hvis linket peger ud af dit site skal du i 
boksen target vælge _blank.

Åbn en htmlside
Placér et billede på siden

Markér billedet

Vælg værktøj

Indram det ønskede

Udfyld den 
alternative tekst

Skriv i koden

Skiv adressen

Hotspot
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Navigationsseddel

Et afsnit, et ord, en sætning eller et bogstav 
kan laves til et link.

Vælg symbolet Point to File i Properties. 
Træk symbolet til den ønskede fil i Filema-
nager.

Angiv den tekst der skal vises i den lille 
gule boks, der fremkommer, når man holder 
musen på linket.

Vælg symbolet Point to File i Properties. 
Træk symbolet til den ønskede fil i File-
manager.

Programmet sætter automatisk en blå 
ramme om billedet for at vise, at der er tale 
om et link. Fjern den ved at skive 0 i feltet 
Border i Properties.

Ønsker du at linke til et andet sted på inter-
nettet, skal den nye side åbnes i et selv-
stændigt browservindue. Vælg Target_blank 
i Properties.

Åbn en htmlside
marker teksten

Opret link

Giv linket en titel

Markér et billede

Fjern rammen

Eksterne links

Links
Te

ks
t

B
ill

ed
e
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Navigationsseddel

Vælg F12

Effekten skal sættes ind på siden.

Billederne skal ikke trækkes ind på siden. 
De bliver først synlige, når stien er angivet.

Original Image ses når siden åbnes.
Rollover Image ses, når musen føres hen-
over billedet på siden.

Effekten kan ikke vises i Dreamweavers 
design vindue.

Åbn en side

Vælg symbolet Rollover 
Image fra Image menuen

Angiv stien til de 2 bille-
der der skal anvendes

Se effekten i browseren

Rollover Image
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Fase Forklaring Navigation

Navigationsseddel

På den ene htmlside indsættes det foto, der 
skal være klikbart, som oftest det mindste.

Markér billedet og indsæt en »havelåge« 
(#) i linkfeltet i Properties. Dette giver et 
dødt link.

Åbn Tag Inspector, klik på det lille plus 
og vælg Open Browser Window fra rulle-
menuen.

Angiv stien til den anden htmlside.Det er 
den, der er PopUp vinduet. Angiv målene 
på det store foto, der skal sidde på denne 
side.

Indsæt det største foto på den anden html 
side.

For at få billedet til at gå helt ud til venstre 
kant og helt til top, fjernes sidens default 
left og top margin. Åbn Page Properties i 
Properties Paletten og tast 0 ud for de to 
marginfelter.

Opret 2 htmlsider

Indsæt foto

Link

Tilføj effekten

Indtast værdierne

Indsæt foto

Fjern margin 

PopUp vinduer 
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Fase Forklaring Navigation

Navigationsseddel

Det er en god ide at planlægge, hvilke 
styles du ønsker at anvende, og hvordan de 
skal se ud. Opret en index.html og åbn den.

Ved at åbne fanen kan der vælges et CSS.

I bunden af CSS paletten findes symbolet 
for et nyt CSS.

Vælg Tag, Class eller ID. Rækkefølgen, 
man opretter styles i, er underordnet. Der 
kan altid tilføjes flere, og de kan til enhver 
tid redigeres. Det eksterne CSS skal opret-
tes som New Style Sheet File. Vælg OK.

Programmet åbner dialogboksen til arkive-
ring. Giv filen navnet basic.css. Den skal 
ligge i roden af sitet. Arkiveringen skal kun 
foretages én gang. Man kan anvende flere 
eksterne Style Sheets i samme site.

Efter arkiveringen åbner programmet CSS 
editoren. Her foregår selve definitionen af 
de enkelte styles. Her er vist et Tag Style  
kaldet body indeholdende Font-Family og 
Font-Color.

Det er altid muligt at ændre i stylen efter 
oprettelsen. Dobbeltklik direkte på den 
aktuelle style, vælg symbolet der viser en 
blyant, skriv direkte i CSS filen eller redigér 
i oversigten, som ligger i bunden af CSS 
paletten.

Opret et nyt site i DW

Åbn CSS paletten

Vælg New CSS Rule

Vælg den første style

Arkivér filen 

Definér stylen

Redigér stylen

Opret et eksternt CSS

Se afsnittet »Opstart« om oprettelse af et 
nyt site
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Fase Forklaring Navigation

Navigationsseddel

Vælg symbolet for en tabel i øverste værk-
tøjslinje.

Foretag de ønskede indstillinger. Det er en 
rigtig god ide at beholde borderen på, så 
længe du arbejder med tabellen. 
 

Man skriver direkte i cellerne, og billeder 
trækkes ind fra Filemanager.

Tabeller kan kombineres med CSS og 
styles som ethvert andet element.

Åbn en side

Indsæt en tabel

Definér rækker og celler

Indhold i tabellen

Tilpasning

Tabeller
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Fase Forklaring Navigation

Navigationsseddel

Klik på symbolet for et han- og hunstik i 
Filemanager.

Vælg servers og klik på det lille +

Vælg FTP. Programmets indbyggede FTP-
program indeholder alt, hvad du skal bruge 
til upload processen.

Du har fået de oplysninger udleveret af 
din underviser, der er nødvendige for at få 
forbindelse til webserveren. Ved at klikke 
på Test får du at vide, om forbindelsen er 
etableret.

Vælg symbolet for webserveren i File-
manager.

Træk filerne du ønsker at uploade fra vin-
duet med dine lokale filer til webserverens 
vindue. Det er afgørende, at hierarkiet er 
identisk i begge vinduer, ellers virker dine 
links ikke.

Åbn en browser og kontroller at sitet virker.

Forbind til webserveren

Kategori

Tilslutningsmetode

Indtast de nødvendige 
oplysninger

Åbn webserveren

Upload

Test

Upload 

56



I gang med Dreamweaver

Afsluttende  
opgave

Opgave 

Du skal nu lave en selvstændig, afsluttende opgave ud fra det 
medfølgende materiale samt evt. yderligere fotos, du selv frem-
skaffer. 
Du skal selv designe sitet, og det er meningen, at du skal anvende 
de ting du har gennemgået på kurset. Her følger nogle ideer og 
retningslinjer.

Sitet skal være opbygget af div’er.
Der skal anvendes eksternt CSS.
Følgende skal indgå:

Omfang
Sitet skal bestå af forside (index.html) samt 2 undersider. 

Tekst
Teksten foreligger i elektronisk form. Teksten er opdelt i 3 afsnit, 
og hvert tekstafsnit hører til en side: index.html, emil.html og ha-
ven.html.

Billeder 
Billedmateriale foreligger. Der er lidt af hvert, store og små, så du 
selv kan bestemme designet. Du er velkommen til at supplere med 
flere billeder, dog skal alle ophavsrettigheder overholdes.

Links 
Der skal være et eksternt link til museets hjemmside:  
www.nolde-stiftung.de

Rollover
ae.gif og ae1.gif bruges til rollover.

Hotspot
Bestem selv hvordan effekten kan implementeres.

PopUp vindue
Bestem selv hvordan effekten kan implementeres.

Tabel
Bestem selv hvordan en tabel kan implementeres.

Upload opgaven som aftalt med din underviser.

God fornøjelse!
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